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5 Information about Replacing a Medicare Card
L

Ifyour Medicare card is lost, stolen or damaged. you can ask for a new one at this website.

What is a Medicare Card? » The Medicare card looks like the red, white and blue card shown here. e
« Your Medicare card is your proof that you have Medicare health insurance. __=eess Tt
+ You can use this application only to request a Medicare card. If you need a ......
Medicaid card, please contact your state Medicaid office. :'.::n

What You Should Know '« Your Medicare card will arrive in the mail in about 30 days.
 Itvill be mailed to the address Social Security has on file for you
 If you need proof that you have Medicare sooner than 30 days. you also can request a letter which
you will receive in about 10 days

 If you need proof immediately for your doctor o for a prescription, visit your nearest Social Security
offce.

« For security reasons, there is a 30 minute time limit to complete each page. You will be given notice
when you are about to time out and can get more time to finish
 You can read more about Social Security’s Intemet policy here.

If You Have Moved + fyou have moved and have ot reported this to us, you will need to report this change to us before.
We can process your request.
« Ifyou have moved and have reported this to s recently, you will need to contact us before we can
process your request.

Block access to your ffyou want to prevent online and automated telephone access to your personal information, you can
personal information block access to your personal information

FiRSTGOV. Privec Policy | Accessbilty Policy | Linking Policy | Site Map GovBenefits
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The Privacy Act Statement

Paperwork Reduction Act

s Public Agreement

‘Social Security provides this website for your convenience

‘Social Security is allowed to collect the facts on this form under Section 205 of the Social Security Act. We
need these facts to quickly identify who you are and provide the information you requested. Giing us these
facts is voluntary. However. without them we may not be able to give you the information that you want. The
‘Social Secuity Administration will not use the information for any other purpose. If you want to read more.
information on this subject, read The Collection and Use of Information from Your Application

This information collection meets the requirements of 44 U.S.C. § 3507, as amended by section 2 of the
Papenwork Reduction Act of 1395 You do not need to answer these questions unless we display a valid
Office of Management and Budget control number. The OMB control number for this form is 0960-0596,
expiration date 09/30/2012. We estimate that it will take about 10 minutes to read the instructions, gather
the facts, and answer the questions. You may send comments on our time estimate above to: SSA, 1338
Annex Building, Baltimore, MD 21235-0001. Send only comments on our time estimate to this address,
not the completed form.

By using this website, you agree to ts limitations

Form Approved: OIB No. 0960-0596
Expires 0973022012
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Form Approved: OIB No. 0960-0596
Expires 0973022012

To start your request, we need to know who you are. Please provide the following information to identify yourself.

Your Social Security Number:
Use your own number even if you are
receiing benefits as a spouse, child, or
parent under another person's number.

First Name:
Enter Your First Name.

Middle Initial:
Enter Your Middle Initial

Last Name:
Enter Your Last Name

Suffix:
Select a Sufix (if any)

Other Last Name (if any):
For example, your name as shown on a
recent letter fom Social Securiy.

Your Date of Birth: A .
Month, Day, Year

Have you had a recent change o

of address that has not been

reported to Social Security?
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Reason for Replacement

To complete your request, please indicate why you need to replace your Medicare card. This information is collected for statistical purposes only
‘and will not affect the processing of your request.

Why do you need a -
replacement Medicare card?
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Thank you !

We received your request for a replacement Medicare card on March 23, 2011

What You Should Know

+ You should receive your replacement Medicare card by April 22, 2011

 Itwill be mailed to the address Social Security has on file for you

 Ifyou do not receive it by April 22, 2011, please call us Monday-Friday 7:00 a m.-7:00
p.m. at 1-800-772-1213 or, if you are deaf or hard of hearing, on our TTY number at 1-
8003250778

Do you need proof of
Medicare sooner?

We can mail you a letter as proof of
your Medicare benefits in 10 days. If
you need proof of your Medicare
benefits immediately, contact your
nearest Social Secuity Offce.

Yes, | want to request a letter now.
No, I don't want to request a ltter now.

We suggest you use your browser's “Print” function to print this page for your records
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,T\ Cookies Not Enabled
g

To use this intemet application, you must enable "cookies” on your computer. We use "session cookies™
that we store on your computer only during your visit. The session cookie keeps you from losing information
youve entered for a business transaction with us if, during your visit, you leave our website and retum

‘Once you tum off your computer or stop using the Intemet, the cookie is erased.
To enable cookies, follow the instructions below for the browser you're using
Microsoft Internet Explorer 6.0+

« Select "Intemet Options” from the Tools menu

« Click on the "Privacy” tab.

 Click the "Default” button (or manually slide the bar down to "Medium") under "Settings”
« Click "OK"

Microsoft Internet Explorer 5.x

Select "Intemet Options” from the Tools menu.
Click on the "Security” tab.

Click the "Custom Level” button.

Scroll down to the "Cookies” section.

‘Set "Allow cookies that are stored on your
‘Set "Allow per-session cookies” to "Enable”
Click "OK".

mputer” to "Enable”.

illa Firefox (1.0 final release and earli

Go to the "Tools™ menu
Select "Option
Select the "Privacy” icon in the left panel

Check the box corresponding to "Allow sites to set cookies”
Click "OK" to save changes

Netscape 7.1/Mozilla 5.0

Select "Preferences” from the Edit menu

Click on the arrow next to "Privacy & Security” in the scrolling window to expand.
Under "Privacy & Security”, select "Cookies

Select "Enable all cookies”

Click "OK".
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« Select "Intemet Options” from the View menu
Click on the "Advanced” tab.

Scroll down to find "Cookies™ within the "Security” section
Select "Always accept cookies”.

Click "0K".

Netscape Communicator 4.x

Select "Preferences” from the Edit menu
Find the "Cookies” section in the "Advanced" category.
Select "Accept all cookies” (or "Enable all cookies”)
Click "OK".

g

Start Over
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How to Report a Change of Address and Request a Replacement Card

You told us you have moved and have not reported this to us. To report your new address and request a
replacement card at the same time, please call or visit Social Securty.

To Contact Social Security:
« Inthe United States:

 Call ourtoll-free number 1-800-772-1213. If you are deaf or hard of hearing, call our tollree
“TTY" number, 1-800-325.0778. Representatives are available Monday through Friday between
Tam and 7 pm

o Call orvisit your local Social Securty office. You can get directions and a map to your local
‘Social Security Ofice by visiting the Field Offce Locator

 Outside the United States, call orvisit
o Your nearest Social Security office.
o The closest US_Embassy or consulate, or

o The Veterans Affairs Regional Offce (VARO) in the Philippines.

Warning: I you select any of the links above, you will leave this secure site and these pages vill open a
new browser window. You will automatically return to this page when you close the new browser window.

SSA Home
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How to Request a Replacement Medicare Card If You Cannot Request It Online

Were sorry you cannot request a replacement Medicare card online You must call or visit us to request a
replacement card. If you are

« inthe United States, you can —
o call us at 1-800.772-1213 Monday through Friday between 7 a.m. and 7 p.m.
o call our tollfree TTY number. 1-800-325.0778, if you are deaf or hard of hearing, Monday
through Friday between 7 am. and 7 p.m., or
o visit your local Social Securty office. You can get directions and a map to your local Social
‘Security Offce by visiting the Field Offce Locator

« outside the United States, you can contact -
© your nearest Social Security office,
o the closest US_Embassy or consulate, or
o the Veterans Affairs Regional Ofice (VARO) in the Philippines

Warning: I you select any of the links above, you willleave this secure site and go to the copy of these
pages on a new browser. You will automatically retur to this page when you close the new browser

SSA Home
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How to Request a Replacement Medicare Card If You Recently Changed Your

H° Address

You told us you have moved and recently reported this to us. To ensure your privacy, you cannot request a
replacement Medicare card online at this time. You must call or visit us to request a replacement card

To Contact Social Security:
« Inthe United States:

 Call ourtoll-free number 1-800-772-1213. If you are deaf or hard of hearing, call our tollree
“TTY" number, 1-800-325.0778. Representatives are available Monday through Friday between
Tam and 7 pm

o Call orvisit your local Social Securty office. You can get directions and a map to your local
‘Social Security Ofice by visiting the Field Offce Locator

 Outside the United States, call orvisit
o Your nearest Social Security office.
o The closest US_Embassy or consulate, or

o The Veterans Affairs Regional Offce (VARO) in the Philippines.

Warning: I you select any of the links above, you will leave this secure site and these pages vill open a
new browser window. You will automatically return to this page when you close the new browser window.

SSA Home
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5 Information About Time Limits
il ¢

‘There are time limits for your work on each page. You will receive a warning after 25 minutes, and you will
be able to extend your time on the page. After the third waring on a page. you must move to another page
or your time will run out, and your work on that page will be lost.

IFyou have tumed JavaScript offin your browser, you will not receive any warings. If you do not go to
‘another page after 30 minutes, your report session will end, and your work on the last page will be lost.

SSA Home
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Is it safe to transmit.
information to the Social
Security Administration over
the Internet?

What is encryption?

Why is special software
necessary to access the
Internet application?

Why SSL?

Internet Security Policy

SSAis taking all reasonable and proper measures, including encryption, to ensure that your personal
information is disclosed only to you. However. the Intemet is an open system and there is no absolute
quarantee that others will not intercept the personal information you have entered o requested and
decrypted. Although this possibility is remote, it does exist.

Encryption means that all information relating to you and your account is scrambled and locked with a
mathematical key during the electronic transfer. Most browsers have an icon such as a key or alock to
represent an encrypted mode or session. A broken ke, open lock. or no lack indicates that the session or
mode is not encrypted.

So that your online request can remain confidential, SSA uses a security protocol (method) called Secure
‘Sockets Layer (SSL) for this application. You must use a Web browser that supports SSL. Netscape.
Navigator and Microsoft Intemet Explorer are two browsers that support SSL. Using this security protocol,
allinformation sent between your computer and our server is encrypted before being sent on the Intemnet.

SSL provides a high level of security and is the security protocol supported by more browsers than any
other. It is estimated that about 92% of Web browsers have an SSL browser available for their use.

I have the right software and | We have found that a number of business, government, and educational networks do not have their firewalls

am trying to connect during
your posted business hours,
but| still cannot access your
form. Why?

configured to allow passage of secure Web traffc. Check with your systems administrator to determine if
this is the case at your site. Ifthis is the case you will not be able to access this application web site.

Close this window to continue your request.
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Jma\. Our records show you recently requested a replacement Medicare card.
il

You should receive your replacement card in the mail within 30 days at the address we have on record.

If you do not receive your card within 30 days or if you have other questions, please contact Social Security
by telephone on Monday - Friday between 7:00 a.m.-7:00 p.m. at 1-800-772-1213. If you are deaf or hard of
hearing, our TTY number is 1-800-325-0778. You can also contact your local Social Security offce.

Backto Social Securty Webste.
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Railroad Retirement Board Information

Our records show that your Medicare is handled by the Railroad Retirement Board. If you have Medicare
through the Railroad Retirement Board, Social Security cannot issue you a replacement Medicare card.

To request a replacement Medicare card, contact the Rairoad Retirement Board. Please call their toll-ree
number. 1-800-808-0772, visit the RRB website or contact your Railroad Retirement Board field offce.

Back o Social Secuty Webste
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The Information You Entered Does Not Match Our Records

Please check this « Ifyou typed the wrong information, you will need to correct it before continuing.
information: « ffthe information is correct, contact Social Security. Be sure to tell the representative that you tried
to complete your request online and received this message.

To contact Social Security: « Call our tollfree number, 1-800-772-1213. Explain that you are unable to complete your request
online. I you are deaf of hard of hearing, call our toll-ree “TTY" number, 1-800-325.0778.
Representatives are available Monday through Friday from 7 a.m. to 7 p.m.
+ Goto your local Social Security Offics and tell the representative that you were unable to complete
your request.

SSA Home
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/7N The Information You Entered Does Not Match Our Records

FFthe information that you provided is correct, then it may be necessary to corect your Social Security
record.

To resolve the discrepancy: « Call ourtoll-free number, 1-800-772-1213. If you are deaf or hard of hearing, call our toll-free "TTY"
‘number, 1.800-325.0778. Representatives are available Monday through Friday from 7 am.to 7 p.m
« Call orvisit your local Social Securty Office.

SSA Home
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\ This Service Is Not Available At This Time

This service is available during the following hours (Eastem Time).

Monday through Friday: 5:00 AM - 1:00 Al
Saturday: 5:00 AM - 11:00 PM
‘Sunday: 8:00 AM - 10:00 PM
Holidays: 5:00 Al - 11:00 PM

SSA Home.
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FFthe information you gave us is correct and you are currently receiving benefits, online access to your
‘account may be blocked. For assistance, please call us at 1-800-772.1213, Monday through Friday
between 7 am._and 7 p.m.If you are deaf or hard-ofhearing, call our toll-free TTY number, 1-800-325.0778,
Monday through Friday between 7 a.m. and 7 p.m.

SSA Home
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Jma. We Are Processing Your Request...
%l ¢
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We are sorry for the inconvenience but we cannot process your request at this time

If you stillwish to complete your request online, you may try again later. If you want to know about other
options for completing this request you may call 1-800-772-1213 or contact your local Social Security office
If you are deaf or hard of hearing, call our tall-free "TTY" number. 1-800-325.0778. Representatives are
available Monday through Friday from 7 2.m. to 7 p.m.

SSA Home
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You Do Not Have Medicare Coverage

Our records show that you currently do not have Medicare coverage. Please see the requirements to receive
Medicare benefits

fFyou have any questions, please visit the Medicare website
fFyou have other questions, you can contact Social Security by telephone on Monday - Friday between 7:00

2.m.-7:00 p.m. at 1-800-772-1213 or, if you are deaf or hard of hearing, on our TTY number 1-800-325-0778.
You can also contact your local Social Security office.

Back o Social Secuty Webste
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You Have Reached the Limit on the Number of Requests

We have not been able to match the information you entered with our records.

To resolve the discrepancy: o Call our toll-ree number, 1-800.772-1213. If you are deaf or hard of hearing, call our toll-free "TTY"
number, 1-800-325.0778. Representatives are available Monday through Friday from 7 a.m. to 7 p.m.

« Call or visit your local Social Secuiity offce.

SSA Home.
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Your Session Has Expired

We are sorry for the inconvenience but your session has expired.
HFyou would like to continue completing your request online, you may sign in again by selecting the button

below.

SSA Home

Retum to Request
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